
INSTALLING THE PROGRAM FROM THE CD-ROM

This CD contains a Master Installer program that provides an easy and convenient way to
install the programs on the CD. Follow these instructions to use the Master Installer.

1. Insert the program CD into the CD-ROM drive.

2. From the Windows Program Manager, click once in the File menu option to
display the File menu and select Run.

3. In the Run dialog box, type D:\INSTLL.EXE (note the spelling, no “A”), and
press Enter. If your CD-ROM drive letter is not D, substitute accordingly.

4. The Master Installer main screen is displayed and you are presented with a list of
products to choose from. Make your selections from the list and click on Install to
continue. Master Installer will launch the individual installers for each of the
products selected, and return to the Master Installer screen. Follow the on-screen
instructions to complete the installation for each program. Please note that some
installations may restart your Windows session.

If you encounter problems installing several programs at once, quit the Master Installer
program, and restart it. Install one program at a time.

THE ON-LINE USER’S GUIDE
Documentation for these products have been provided in an on-line format, along with a
Viewer utility. To view the manual, you must first install the On-line Document Viewer
program from the CD. To do this, follow the instructions in the above section. The last
option shown in the Master Installer list box installs the On-line Document Viewer
program to your hard drive. Please note that this installation restarts your Windows
session.

After the installation is complete, run the On-line Document Viewer program and from
the Open File Dialog box, select the file called MANUAL.PDF which is located in the
MANUALS directory of the program CD (e.g. D:\MANUALS\MANUAL.PDF). The
Viewer also contains a full and comprehensive help system to assist you in learning how
to use the documentation.

InstallationInstallation



 

Troggle Trouble

 

™

 

 Math

 

Version 1.x

 

MECC
6160 Summit Drive North

Minneapolis, Minnesota 55430-4003
612/569-1500

http://www.mecc.com/

ISBN 0-7929-0865-1 Printed in the U.S.A. September 1995

 

For MECC Technical Support, 
see page 19.

 

Please do not make illegal copies of this software. The software you are 
using was produced through the efforts of many people: designers, 
artists, programmers, distributors, retailers, and other dedicated workers. 
The costs of developing this and other software programs are recovered 
through software sales. The unauthorized duplication of personal 
software raises the costs to all legitimate users. This software is protected 
by federal copyright law. Copying software for any reason other than to 
make a backup is a violation of law. Individuals who make unauthorized 
copies of software may be subject to civil and criminal penalties.

As a member of the Software Publishers Association (SPA), MECC 
supports the industry’s efforts to fight the illegal copying of personal 
computer software. Report copyright violations to SPA, 1730 M Street 
NW, Suite 700, Washington DC 20036-4510, 800/388-7478.

Copyright © 1994 by MECC. All rights reserved. This software and 
manual may not be copied or transferred in whole or in part except as 
permitted by U.S. Copyright Law or as authorized in writing by MECC. 
MS-DOS and Windows are registered trademarks of Microsoft 
Corporation. The MECC name is a registered trademark of MECC. 
MECC’s Learning Guarantee and 

 

Troggle Trouble

 

 are trademarks of 
MECC. All other company and product names are trademarks or 
registered trademarks of their respective owners.

 

TT-Win-H book  Page 2  Friday, November 10, 1995  6:13 PM



 

MECC’s Learning Guarantee

 

™

 

Guaranteed learning. Guaranteed fun. We’re so sure kids will improve in the 
key learning areas included in this product that we guarantee it. If you don’t 
see improvement as a result of regular use of this software, we’ll exchange it or 
give you your money back. Simply return the complete package, along with a 
receipt showing the store name and location, to MECC within 30 days.

Learning objectives for 

 

Troggle Trouble Math

 

:

• Improve math skills, reasoning, and confidence. 

• Develop proficiency with basic facts and algorithms.

• Use counting, grouping, and place value to understand our numeration 
system.

• Select computation techniques appropriate to specific problems.

• Develop operation sense.

• Develop number sense.

• Construct number meanings through concrete materials and examples.

• Build an awareness of the properties of an operation, the relationships of 
operations, and the effects of operations on pairs of numbers.

• Practice using operations in a wide variety of problem structures.

• Use a variety of mental computations and estimation techniques.

• Use calculators in appropriate computational situations.

MECC
6160 Summit Drive North

Minneapolis, Minnesota 55430-4003
612/569-1500

http://www.mecc.com/
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Getting Started

Requirements
This is wh

68030 pro

4 MB (meg

 Double-sp

 System 7.0

 256 colors
(10” color 

Macin
Insert the C ou
can create 
Trouble M

Windo
This CD u
“Installing le
Trouble M

Install
Insert the C  type
D:Setup. ( te a
MECC pro
at you need in order to run the Troggle Trouble Math software program:

Macintosh Windows

cessor 25 MHz 486SX

abytes) of RAM memory 4 MB (megabytes) of RAM memory

eed CD-ROM Drive  Double-speed CD-ROM Drive

 (or later) Microsoft Windows 3.1;

DOS 5.0 or later required

 or more with a 12“ or  larger color monitor
on Color Classic)

640x480 256-color Display

Windows-compatible sound card

tosh Start-up
D in your CD-ROM drive and double-click the Troggle Trouble Math icon. If you wish, y

an alias to put on your hard drive for the Troggle Trouble Math CD. (Highlight the Troggle
ath icon on the CD and select Make Alias from the Finder’s File menu.)

ws Start-up
ses a Master Installation program to install all programs. Please refer to the section titled
 The Program From The CD-ROM,” for complete instructions. To manually install Trogg
ath do the following:

ing The Program Manually
D in your CD-ROM drive. From the File menu, choose Run. In the Command Line box,

If your CD drive is not drive D:, type the appropriate letter.) The set-up program will crea
gram group and a Troggle Trouble Math icon.
1



Starting the Program
1. Double-click on the Troggle Trouble Math icon.

2. When the title screen appears, click on the Introduction button.

Play
The ob d
TROG look for
clues a arky, or
they'll nta will
call yo

It is a  14.

Gett
Troggl

1 lp you
 Math

2 elp you

This u ccess.  If
neither s.
ing the Game
ject of the game is to rescue the Muncher, who has been captured by a robot troggle name
. To do that, you need to guide your dog, Sparky, through the dangerous Troggle worlds, 
bout TROG, and troggulate the hordes of mutant troggles. Don't let the troggles get to Sp

 munch a whole box of Sparky Treats. When you run out of boxes of Sparky Treats, Mage
u home.

good idea to save your game frequently. For more information, see "Save Game" on page

ing Help
e Trouble Math has on-screen help.

. On a Macintosh computer, go to the Apple menu and choose Help. You can then choose the he
need from a menu of help topics. Or, go to the Balloon Help menu and choose Troggle Trouble
Help.

. On a Windows computer, go to the Help menu and choose Contents You can then choose the h
need from a menu of help topics.

ser's guide should also help you to learn how to play the game. It also has a few tips for su
 of these sources helps, please call MECC Technical Support. See page 19 for instruction
2
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We’ve Got Troggle Trouble!

 

Entry: 6/10.

Last night, I was sitting in my lab when strange signals started coming 
over the troggle-scope. I looked up from my pink lemonade to see the 
shadow of a strange robot-troggle swoop down and capture the 
Muncher. Then, as quickly as he came, he disappeared without a trace! 
Out of range of the troggle-scope or into another dimension! I nearly 
spilled my lemonade! 

Sparky jumped up from his nap and started barking like crazy. It’s like 
Sparky could smell troggles right outside the door at the top of the 
stairs! I would have taken him out. But just then, the troggle-scope 
started lighting up like the Fourth of July. Dozens of sightings! We’ve 
got an invasion of mutant troggles on our hands!

So, I went into high gear and stayed up late working on my latest 
invention…the troggulator. It uses the power of numbers to troggulate 
troggles and send them back to their own dimension. It’s a good thing 
I’ve just put the finishing touches on it and it’s ready for a volunteer to 
take it out for a test run in Santa Bongo. 

Sparky can hardly wait to go for a walk and keeps whining at the 
bottom of the steps.

Lately, I’ve been picking up lots of strange signals. Troggles are 
everywhere! I’ll stay by the troggle-scope in my lab… and wait for a 
hero to rescue the Muncher.

 

Lab Notebook

 

Property of: 

 

Magenta
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Title Screen Buttons

The Game Screen

See the 
introduction.

Use your 
troggulator 
to calculate. 
See page 7.

Check the 
high-
score list.

Start a saved game. 
See “Save Game (S)” 
on page 14.

Start a new 
game in Santa 
Bongo. See 
page 14.

Sparky 
follows the 
clicks of the 
bone. 

 

Start with 
three boxes of 
Sparky 
Treats. 

This is your 
point total.

Fill up the empty box with doggy 
treats you find. When it’s filled, it 
becomes a new box of Sparky 
Treats. 

This shows 
your level.

This is your 
troggulator. 
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Exploring Troggle Trouble

The watchband shows that you 
have three Sparky Treat boxes left. 
You’ve collected a doggy treat, 
you’ve scored 1114 points, and 
you’re on the first level.

There are five worlds in Troggle Trouble Math: 

• Santa Bongo

• Great Gobble Desert

• Muncher Mystery Cave

• Troggle Swamp

• Frankentroggle’s Space-Time Warp

Your job is to track down TROG, make it through the worlds, and rescue the 
Muncher!

This is your 
troggulator–
ready for 
troggles.

Sparky sits down next to the 
Muncher Fountain in Santa Bongo.

 

TT-Win-H main  Page 5  Friday, November 10, 1995  6:14 PM



 

6

 

The Worlds of Troggle Trouble 

 

According to the troggle-scope in my lab, every world has some of the 
same types of things.

 

• Each world has something in it that TROG, or Frankentroggle, left 
behind. It could be hidden in a puzzle chamber. It could be out in the 
world. 

• Each world has different troggles.
• Each world has an entrance and a passageway to the next world. 

 

The entrances and passageways are blocked until you find the 
secret TROG or Frankentroggle evidence. Then, they will open up! 

 

• Each world has a landmark or two or three….

 

Using the landmarks you can find your way around, figure out 
where you are, and learn which way to go.

 

• Each world has three puzzle chambers.

 

Puzzle chambers hold the secrets to TROG and Frankentroggle. In 
order to find the secrets, solve the three puzzles that unlock the 
treasure chest. 

 

• Each world has some things that give out and take away Sparky 
Treats if you bump into them.

• Each world has some troggles that can’t move. But, if you bump into 
them, they take away a whole box of Sparky Treats!

 

There are three reasons why Sparky stops walking: (1) You didn’t click 
the bone. (2) Sparky bumped into something. (3) Sparky’s at the edge of 

 

Lab Notebook

 

Property of: 

 

Magenta
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Using the Troggulator

The Energy Bar shows how 
much energy you have left.

The Message Area gives you 
info on using the troggulator.

The Troggulate button puts up the 
safety shields and zaps troggles.

The Phone button calls Magenta.

The Power Up button boosts your energy 
with each right answer to math questions.

The Memory buttons activate the 
Troggulator’s memory bubble.

The Display Area shows the numbers 
you’ve entered into the troggulator.

The Keypad keys enter numbers and 
equations. The Orange button, C, 
clears the Display area. The Orange 
button, <<, backs up and clears the 
last character. The yellow buttons 
(÷,x,-,+,=) are operators. The white 
buttons are the numbers.

The +/– button changes numbers from 
postive to negative. The % button 
changes numbers in equations to 
percents. Try: 10+25%. The display will 
show 12.5 as the answer. The 
parentheses reorder operations.
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The Troggulator Notes

 

Dare to compare! Not just an ordinary calculator, it’s a 21st-century, 
personal, digital assistant so advanced, so futuristic, I had to call this 
“The Troggulator.”

 

• It troggulates troggles!

 

Whenever you see troggles, or hear Sparky howl, press the 
Troggulate button, or press the Space Bar, to put up the safety 
shields to protect Sparky from the troggles. Then, enter a math 
problem that equals the number of troggles you see. Every time you 
troggulate, it uses up some of your energy.

 

• It phones home!

 

With the touch of a button, you can stay in touch with me. Get the 
latest word on what to do, where to go, and what it all means.

 

• It powers up!

 

You’ll never have a dead battery as long as you keep an eye on your 
Energy Bar. But if your energy gets too low, you won’t have enough 
energy to troggulate the next group of troggles.

The Troggulator’s other amazing features…

 

• An Energy Bar shows the energy level. It flashes if power’s getting 
low.

• A Message Area shows messages, numbers, and phone calls.
• A Display Area shows the whole equation--not just the last number.
• Color-Coded Buttons make it easy to find the right key.
• A Memory Bubble shows what’s in memory. Press M+ to put a 

number in the memory bubble. M- reduces the number in memory by 

 

Lab Notebook

 

Property of: 

 

Magenta
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Troggulate!

Only the Minus (–) key is active. So, you have to think of a math problem: 
“Something minus something equals 16.” When you’ve got the problem you want, 
press the Troggulate Button again or press the Space Bar and the troggles get 
zapped back to their own dimension.

About Troggulating:

• Troggles can get to Sparky before you press the Troggulate Button and 
munch one whole box of Sparky Treats.

• You can count the number of troggles as they move in formation. Or, you 
can pause the game and count them. 

• Sparky can count troggles, too! Feed Sparky a Sparky Treat through the 
safety shield and Sparky will count the troggles. 

• Troggulating troggles takes a full “mark” off the energy bar.

• You can take as much time as you need. 

• You have to use the “operator” or “yellow key” in the math problem you 
use to troggulate troggles.

The Troggulator 
is ready to 
troggulate! The 
safety shield 
goes up when 
you push the 
Troggulate 
Button down or 
press the Space 
Bar. 

Sixteen Troggles 
surround Sparky, 
who is safe 
inside the safety 
shield.
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Power Up!

Every correct answer boosts the 
energy bar up a notch. If you get the 
energy bar back to full power, the 
Power Up session will automatically 
end.
Every Power Up problem shows up at 
the top of the Message area. Use the 
number buttons in the Keypad to 
answer the problem and press the 
Equal sign (=) button or the Enter key.

The stopwatch ticks away the 
seconds. When time runs out, the 
Power Up session is over. If you 
want to end the Power Up session 
early, press the Power Up button 
again. Or, click in the world with your 
bone cursor. Sparky will wake up 
and the Power Up session will end.

Your answers to each Power Up 
problem show up in the Display area.

The only keys you can use in Power 
Up are the Clear button, the 
Backspace button, the numbers, the 
fraction bar, the decimal point, and 
the equal sign.

Power Up math problems, like all the other math in the program, are set to the 
grade level you chose at the beginning of the game. During the game, this level 
adjusts so that if you’re having problems, it will bump to an easier level. If the math 
is getting too easy, it will bump up to a more difficult level.
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Answer the Phone!

If you make the call, it costs you a 
little bit of energy. If Magenta calls 
you, you’re talking on her dime–so to 
speak.

Magenta shows up in the Picture-
Phone. 

You can hear her message and read 
it. Magenta works in her lab and 
studies the information. Then, she 
tells you what to do next. If you 
forget, you can call her back and she 
will remind you of what to do or give 
you another clue.

The phone buttons don’t work. You 
can’t call anyone but Magenta. If you 
want to stop the phone call, press 
the End button. The phone is not a 
toy. Don’t play with the phone. 

The Phone button automatically dials Magenta’s lab. So, whenever you press the 
Phone button, you will connect with Magenta. Magenta will call you whenever you 
find something interesting. You can call her any time of the day or night. You’ll 
never get her answering machine. You’ll never have to leave a message.
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Solve Puzzles!

In each puzzle chamber, 
there is a treasure chest 
with three locks on it. 
When you solve a 
puzzle, a lock is opened. 
After you solve three 
puzzles, you will find out 
what might be hidden in 
the chamber.

Puzzle chambers hold the secrets of Muncher, TROG, and Dr. Frankentroggle. 
First, you have to find the chambers. Then, you have to solve three puzzles. 
Each time you solve a puzzle, you earn points and unlock one of the locks on 
the treasure chest. When the treasure chest is open, a treasure will be placed 
outside the puzzle chamber. When that happens, just click on the Exit sign to 
leave the chamber and see what you’ve found. 

These puzzles, like all the other math in the program, are set to the grade level 
you chose at the beginning of the game. During the game, this level adjusts so 
that if you’re having problems, it will bump down a level. If the math is getting too 
easy, it will bump up a level.

Inside a puzzle 
chamber, you 
use the 
troggulator to 
solve puzzles. 
You can also 
call Magenta 
and Power Up.

Click on the Exit sign to leave 
the puzzle chamber. You can 
leave whenever you want and 
return later. If any locks have 
been opened, they will still be 
opened when you return.

Read the puzzle 
carefully. Use 
the troggulator to 
figure out the 
answer. When 
you think you’ve 
“got it,” press the 
Use It button 
while the answer 
is in the display 
area.
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Walk the Dog!

Walking Sparky.

• Click the bone, and Sparky walks to the spot you clicked. 

• Click to the left of Sparky, and Sparky walks to the left. 

• Click to the right, and Sparky walks to the right. 

• Click above Sparky, and Sparky walks up towards the top of the screen. 

• Click below Sparky, and Sparky walks down towards the bottom of the 
screen.

• Hold down the mouse button and drag the bone, and Sparky follows 
wherever you drag it.

• Use the arrow keys, and Sparky will walk up, down, left, and right.

Sparky will stop walking if…

• Troggles appear—Sparky stops to howl.

• Sparky bumps into something—Sparky can’t walk through objects.

• Sparky reaches the edge of the world—there’s nowhere to go.

Bone.

Sparky 
follows the 
Bone 
wherever 
you click it. 
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Menu Commands
File Menu (Alt-F) Then press the active key.

New Game (N)
Starts a new game. If you are already in the middle of a game, you will get a 
chance to save it before you start the new game.

Open Game…(O)
Opens a saved game. When you see the Open dialog box, double-click on the 
name of the game you want, or click on the name and click on the Open 
button.

Save Game (S)
Saves your place so you can come back to it later. Choose “Save Game” from 
the File menu. Give your saved game a name you will remember. You can use 
up to eight characters, no spaces, or punctuation. 

Save As… 
Saves a game you’ve already saved once with a new name. Give your new 
saved game a name you will remember—like the name of the world that you 
are in. You can use up to eight characters, no spaces, or punctuation. 

End Game…(E)
Closes the current game but does not quit the program.

Report …(R)
The report shows your grade level, your points, and how well you’re doing in 
Adding, Subtracting, Dividing, and Multiplying. The report keeps track of the 
correct answers to adding, subtracting, multiplying, and dividing in 
Troggulating, Power Up math questions, and Puzzle Chambers.

Exit (X)
Exits the program and returns you to the Windows Program Manager.

Game Menu (Alt-G) Then press the active key.

Pause (P)
Use the Pause option if you want to take a break or time-out. Choose Pause 
from the Game menu, or press the P key. A message in the Message Area of the 
Troggulator tells you the game is paused. The game is frozen until you click 
again. There is no time limit for a pause. 
14
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Music (M)
Turn the music off and on by choosing Music from the Game Menu. If the 
check is beside Music, it’s on. If the check is not there, it’s off. 

Sound (S)
Sound controls the sound effects and speech. Turn the sound off and on by 
choosing Sound from the Game Menu. If the check is beside Sound, it’s on. If 
the check is not there, it’s off. 

Settings
In the Settings dialog box, you can 

• Choose faster background graphics if you are using a 386 machine. 
“Faster, less detailed graphics” means that you turn off the 
background graphics for each world. You can run Troggle Trouble 
Math without Faster Graphics. It will be slower,  but it will have more 
detailed background graphics.

• Set a Screen Border to hide the other windows and desktop in the 
background. 
With the border on, clicking outside the Troggle Trouble Math 
window won’t switch you to another program or window. This is a 
great feature for younger kids.

• Clear the Bone-A-Fide Heroes High-Score List.
“Clear the Bone-A-Fide Heroes” means you erase all the names in the 
high-score list. You can’t erase just one name. That wouldn’t be fair.

Help Menu (Alt-H)

The On-line Help contains information on How to Play the Game, How to Use 
the Troggulator, the Troggle Field Guide to help identify troggles, and other 
topics related to Game Content and Settings.
15

             



Macintosh Troubleshooting

Macintosh Problem Solution

When 
couldn
fonts i

 couldn’t
es, puzzle
 font on

When 
Math, i
256 co
to swit
No. It 

 drawn in
 your
itch to
to the
6.

Troggl
sluggis

 to adjust
sponse of
and

 detailed

or” is

I can’t
Music
the Ga

and open

I can’t
music 
Music
out.”

 reinstall
I started, it said it
’t find Geneva 14 & 10
n my system. Why?

The program assumes you have the Geneva fonts in your system and it
find them. Troggle Trouble Math uses that font to display phone messag
text, and other feedback. Use your system disks to reinstall the Geneva
your system, if you want the program to look best.

I started Troggle Trouble
t said it only supports
lors. It asked if I wanted
ch to 256 colors. I said
didn’t start.

Your monitor is not set to 256 colors. Troggle Trouble Math graphics are
256 colors. When you start, the program will ask if you want to switch
monitor to 256-color mode. If you choose yes, it will automatically sw
256-color mode. you can also set the compatible settings yourself. Go 
Control Panels and open the Monitors control panel. Select Colors: 25

e Trouble Math is very
h

You may need to close other programs you have open or you may need
the settings. In most cases, closing other programs will speed up the re
the program. You can adjust several settings that will affect the speed 
response:

1. Select Settings from the Game Menu. Make sure “Faster, less
graphics” is checked.

2. Select Settings from the Game Menu. Make sure “Faster curs
checked.

 hear the Sound or
, but it’s checked under
me menu.

Your sound volume may be set low. Go to your Control Panels folder 
the Sound panel. Make sure the volume is set high.

 hear any sounds or
and the Sound and
 menu items are “grayed

You have deleted or renamed the Troggle Sound File. You will want to
the program. Make sure you are doing a standard installation.
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Windows Troubleshooting

Windows Problem Solution

I ran the Se
Troggle Tro
doesn’t run

re the
e Math

The progra
slowly.

ed to

e

ory
e

tailed
e

Troggle Tro
working fin
disappeare

, but
 of

e part

gle

” This
w.

Sound and
but I don’t

e is
e

t-up program for
uble Math, but it
.

Double-check the requirements. (See “Requirements” on page 1.) Make su
CD is in your CD-ROM drive when you double-click on the Troggle Troubl
icon.

m is running very Your system is probably low on memory. To speed up the program, you ne
make more memory available. Do one of the following:

Close other programs you have open or running. These programs may b
using memory.

Check your Windows documentation for information on freeing up mem
or optimizing Windows, if closing other programs does not speed up th
program.

Go to the Game menu and choose Settings. Turn on the Faster Less De
Graphics mode. The worlds will not have as much graphic detail, but th
speed should improve.

uble Math was
e, but then it

d.

You may have clicked outside the game window. The game is still running
it may be covered by another window. To return to your game, use any one
these options:

If you can see the edge of the game screen, click anywhere in the visibl
of the game screen.

Press Alt + Esc until the game screen appears and is active.

Hold down the Alt key while pressing the Tab key to cycle through the
programs you have open right now. Release the Alt key when the Trog
Trouble Math icon appears.

Go to the Game menu and choose Settings and turn on “Screen Border.
will prevent the game from disappearing if you click outside the windo

 Music are checked
 hear any music.

Make sure your speakers are plugged into the sound card and that the volum
turned up on the speakers and on the card itself. (Most cards have a volum
control just below where the speakers plug in.)
17



Windows Problem Solution

I have a sound card installed
and everything set, but I still
don’t hear any sound or music.

Or, I g
MIDI 
MIDI 
config
will be
Troggl
Sound
items a
can’t s

You may not have installed the drivers for your card. To install the sound
drivers for your sound card, follow the manufacturer’s instructions. (As a part of
the Windows installation, the following sound drivers are installed: MIDI

etters

 click on

the music.

er is
 your
n play the
Music and
hear the

 program
et the Error message, “A
device is not available or
Mapper is not
ured properly. Music
 disabled until you exit

e Trouble Math,” and
 and/or Music menu
re grayed out and I
elect them.

Mapper, Timer, [MCI] MIDI Sequencer, and [MCI] Sound.)

To test your sound card and sound driver:

1. Go to Windows Program Manager. Open the Main group.

2. Double-click on Control Panel. Then double-click on MIDI

3. Mapper.

4. Open the Name listing and select a name which includes the l
“FM” or “Ext. FM.” Then click on Close.

5. Select the Program Manager File menu and select Run.

6. Type MPLAYER Canyon.mid in the Command Line box and
OK.

7. Then, click on the Play button (the lower left button) to play 

If your sound drivers are installed properly and the correct MIDI Mapp
selected, you should hear the song. If you don’t hear the song, contact
computer or sound card manufacturer for set-up instructions. If you ca
canyon.mid song in the Media Player, start Troggle Trouble Math . If 
Sound in the Game menu have check marks next to them, you should 
sound and music for the program.

Or, it is also possible that your MIDI device may be in use by another
application. Try quitting out of any other applications and then run the
again.
18



Windows Problem Solution

The Troggle Trouble  Math
window is small. I want it to
take up more of my monitor.

You are running Windows in a higher resolution mode. The program takes up
more of the screen if you are running in 640x480 mode. To check and change
your Windows Setup, go o the Main window and double-click on Windows

menu

ws. If
ideo

MECC
If you hav

Note 

Note 

Please

Call MEC
commonly
Automated y
features.

Contact M
answer to 
modem to 

You can sp om
8:00 A.M. to

You can w 3.
Setup. Check the display. If it does not say “640x480x256,” go to Options 
and select “Change System Settings.” Press the Arrow next to the display
window and pull down the settings list. Scroll through the list to find
“640x480x256” for your video card. Select it, press OK, and restart Windo
you can’t locate a “640x480x256” setting in the settings list, contact your v
manufacturer to see if they have a driver.

 Technical Support (MECCTECH)
e a problem using MECC software:

the name, product number, and version number of the software.

the brand and model of the equipment involved.

 be in front of your computer when calling.

CTECH (Automated Support System) at 612/569-1678 to receive answers to the most
 asked technical questions about MECC products 24 hours a day, 7 days a week. The
 Support System offers convenient fax-back capability for technical tips as one of its man

ECCTECH On-Line (First Class) Bulletin Board System) at 612/569-1769 to receive an
your question(s) about MECC products or to receive product information. You will need a
use this service.

eak with a Technical Support Representative by calling 612/569-1678, Monday-Friday fr
 5:30 P.M. Central Time.

rite MECC Technical Support at 6160 Summit Drive North. Minneapolis, MN 55430-400
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Credits
Producer Chuck Bilow
Designer, Writer Mike Palmquist
Technical Lead Mark Paquette
Programmers Lester Craven

Al Lathrop
John Ojanen
Kirk Sumner
John Wlazlo

Artists DeeDee Daus
Sheila Kelly
Ed Madrid

Composer Larry Phenow
Sound Designer Glen Anderson
Audio Engineer Chad Iverson
Lead Tester Mark Larson
Testers Marty Euerle

Michael Oltmans
Timothy Roseth
LaDonna Williams

Product Advocate Elizabeth Grobel
Voices Sally Ramirez

Tim Russell
We would like to thank the hundreds of kids that helped us review 
prototypes, play-test early versions, and keep our focus on two guiding 
principles—make it fun and make it fun. Thanks, Jefferson Elementary and 
Tuttle Elementary in Minneapolis! Thanks, Future Kids in Plymouth! Thanks, 
MECC Student Advisory Board members!
We dedicate Troggle Trouble Math to our dogs, past and current: Cinnamon, 
Prince, Stubby, Skeeter, Skippy, Turtle, Nicki, and Rusty.
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MECC Software License Information

 

You should carefully read the terms and con-
ditions of this agreement before using this 
package. Use of any portion of the package 
indicates your agreement to these terms and 
conditions. If you do not agree to these terms, 
return the software along with the rest of the 
package to your place of purchase.

 

Permitted Uses

 

You may:

•operate the software on one computer at a 
time;

•make one backup copy of the software for 
archival purposes or transfer the software 
to a single hard disk or other storage 
device and keep the original software as 
your archival copy;

•install the software on a file server and exe-
cute the software on a network on more 
than one computer, provided that the 
total number of computers simulta-
neously using the software does not 
exceed the number of copies you have 
purchased, that you use the appropriate 
MECC file-server installation software, 
and that the software allows such use;

•install the software on more than one com-
puter if you use a metering device to 
ensure that the number of simultaneous 
users does not exceed the number of soft-
ware copies purchased;

•sell or give the software and all rights 
under this agreement to another person 
together with a copy of this agreement, 
provided you supply MECC with written 
notice and the other party reads and 
accepts this agreement.

     
Prohibited Uses
You may not:

•load and operate the software on more 
than one computer at a time;

•make copies of software documentation 
with the exception of student worksheets;

•modify the software except as permitted in 
the normal use of the product;

•reverse-engineer, disassemble, decompile, 
or make any attempt to discover the 
source code of the software;

•translate or create derivative works based 
on the software;

•remove, obscure, or alter any notice of the 
MECC software copyright or other pro-
prietary rights;

•sub-lease, sell, lend, rent, or lease any por-
tion of the software;

•copy any portion of the software except as 
permitted for archival purposes or for 
transfer to another medium;

•copy any portion of the software docu-
mentation;

•sell or give the software and its documen-
tation to any person or entity in violation 
of the United States Export Administra-
tion Act.

Limited Warranty
MECC warrants that the accompanying soft-
ware will operate on the specified, 
appropriately configured computers. You may 
return this package with proof-of-purchase 
within 30 days for a full refund—no questions 
asked. For 90 days after purchase, MECC will 
replace free of charge any defective original 
software. EXCEPT AS SPECIFICALLY SET 
FORTH ABOVE, MECC AND ITS LICEN-
SOR(S) MAKE NO WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING WITHOUT LIMI-
TATION, THE IMPLIED WARRANTIES OF 
21
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MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, REGARDING 
THE SOFTWARE. MECC AND ITS LICEN-
SOR(S) DO NOT WARRANT, GUARANTEE, 
OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OF OR THE 
RESULTS OF THE USE OF THE SOFTWARE 
IN TERMS OF ITS CORRECTNESS, ACCU-
RACY, RELIABILITY, OR OTHERWISE. THE 
ENTIRE RISK AS TO THE RESULTS AND 
PERFORMANCE OF THE SOFTWARE IS 
ASSUMED BY YOU. THE EXCLUSION OF 
IMPLIED WARRANTIES IS NOT PERMIT-
TED BY SOME JURISDICTIONS. IN NO 
EVENT WILL MECC AND ITS LICEN-
SOR(S) AND THEIR DIRECTORS, 
OFFICERS, EMPLOYEES, OR AGENTS BE 
LIABLE TO YOU FOR ANY CONSEQUEN-
TIAL, INCIDENTAL, OR INDIRECT 
DAMAGES (INCLUDING DAMAGES FOR 
LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, AND THE LIKE) ARISING 
FROM THE USE OF OR THE INABILITY TO 
USE THE SOFTWARE EVEN IF MECC AND 
ITS LICENSOR(S) HAVE BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAM-
AGES. BECAUSE SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF LIABILITY FOR CONSE-
QUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATIONS MAY NOT 
APPLY TO YOU. MECC and its Licensor’s(s’) 
total liability to you for actual damages from 
any cause whatsoever, and regardless of the 
form of the action (whether in contract, tort 
[including negligence], product liability, or 
otherwise), will be limited to $50.

Government End Users
If this software is acquired by or on behalf of 
a unit or agency of the United States Govern-
ment, this provision applies: The software 
(a) was developed at private expense, is exist-
ing computer software, and was not 
developed with government funds; (b) is a 

trade secret of MECC for all purposes of the 
Freedom of Information Act; (c) is “restricted 
computer software” submitted with 
restricted rights in accordance with subpara-
graphs (a) through (d) of the Commercial 
Computer Software-Restricted Rights clause 
at 52.227-19 and its successors; (d) in all 
respects is proprietary data belonging solely 
to MECC; (e) is unpublished and all rights 
are reserved under copyright laws of the 
United States. For units of the Department of 
Defense (DoD), this software is licensed only 
with “Restricted Rights” as that term is 
defined in the DoD Supplement to the Fed-
eral Acquisition Regulation 52.227-7013 
(c) (1) (ii), Rights in Technical Data and Com-
puter Software and its successors, and: Use, 
duplication, or disclosure is subject to restric-
tions as set forth in subdivision (c) (1) (ii) of 
the Rights in Technical Data and Computer 
Software clause at 52.227-7013. MECC, 6160 
Summit Drive North, Minneapolis, Minne-
sota 55430-4003. If this software was acquired 
under GSA schedule, the U.S. Government 
has agreed to refrain from changing or 
removing any insignia or lettering from the 
Software or the documentation that is pro-
vided or from producing copies of the 
manuals or media (except for backup pur-
poses and in accordance with the terms of 
this agreement).
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